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1. About This Document 

This document covers the operation and use of the SMS Tribometrics Software 2.11.  This document does 

not cover analytical techniques or basic scratch or tribology science.  For other documentation on these or 

related subjects, see our website at: 

http://www.surfacemachines.com 

For additional information, or the latest software and manuals for your Scratch 4 Machine, you may contact 

Surface Machine Systems at: 

http://www.surfacemachines.com/swdist 

This website will have our latest software, manuals, and contact information for support. 

1.1. Conventions 

When referring to interface elements of the software, we try to include images of the software interface as it 

would appear.  The elements you will be interacting with at any time will be marked with a red box. 

Critical notes will appear in Red Boxes. 

Notational items or warnings will appear in Yellow Boxes. 

1. Ordered items, 

2. For which the order is important, 

3. Are numbered as such 

► Items which have no order have bullets. 

► Bullets are used to make lists of items with no particular order. 

All references appear as such: a reference.  If your format supports them, references are links. 

http://www.surfacemachines.com/
http://www.surfacemachines.com/swdist
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2. Introduction 

The SMS Tribometrics Software version 2.11 is the latest version of our visual analytic tool.  This tool can be 

used to assist in competitive analysis of certain types of visual criteria for ASTM and ISO scratches, and 

certain types of mar behavior.  The primary purpose of this tool is to discover the onset of whitening, as a 

result of damage to a polymer specimen using the Scratch 4 Machine.  While this software may be used for 

certain other types of analysis, performance is not guaranteed. 

2.1. Software Features 

Capture From Scanner – you can import specimen images directly from your scanner. 

Correlate Scratch Data – the software automatically correlates in situ scratch data with visible scratch 

phenomena using built-in “heads up” analysis tools. 

Load SMS Scratch 3.5, 4, and 5 Data Files – the software can read and understand data files created by 

the SMS Scratch 4 Machine and some of the legacy TAMU 3.5 Scratch Machines. 

Load Kato Tech Co. Data Files – the software can read and understand data files created by the Kato 

Tech Co. Scratch Machine. 

Store Multiple Scratches Per Project – a project keeps all your scratch scan and analysis bundled with 

multiple scratch data files for easy retention. 

Strict and Relaxed Analysis – relaxed analysis now helps to visualize very noisy scratch inputs without 

compromising basic analytical analysis. 

Texture Analysis – texture analysis attempts to suppress background textures prior to analysis. 

Mar Analysis – Tribometrics introduces several mar analytical frameworks under development by Texas 

A&M PTC. 

Specialized Analysis – specialized analytical methods, including 5-Finger go/no-go analysis. 

Parameterized Analysis – the important parameters of analysis are available to the user to help in custom 

analytical processes. 
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Gamma Correction – the software correctly interprets color information. 

2.2. Tribometrics Overview 

The Tribometrics Software (Tribometrics) attempts to be an easy, quick tool for importing and completing 

scratch visual analysis procedures in a consistent manner.  Many of the tasks involved in performing visual 

analysis can be done more reliably and faster with the tool than with traditional manual methods.  

Additionally, the software is internally consistent, which is a critical criterion for performing competitive 

analysis between different materials.  The same “eyes” are now looking at your visual data, rather than trying 

to rely on lab procedures and staff training. 

The software is implemented such that its interface is in “procedure order”. By following the layout of the 

software, any user can be taught to very quickly identify and analyze samples.   Additionally, all files associated 

with the analytical process—the source image, data files, and analysis—are stored in a single convenient 

format file.   

2.3. Hardware Requirements 

The following is a list of hardware requirements necessary to use the Tribometrics Software. 

Security Dongle – a USB security dongle as provided by SMS is required to operate the software.  You can 

acquire these from Surface Machine Systems. 

Photo Scanner – a photo scanner capable of at least 1200 x 1200 DPI (47 x 47 DPmm) optical scanning is 

required.  Be careful to check that the scanner supports an optical zoom, rather than software interpolation.  

For operation with the Tribometrics Software, the scanner must support Windows Image Acquisition. 

Color Correction Card – a supported Color Correction Card.  These can be acquired from Surface 

Machine Systems. 

Windows PC – A Windows PC running Windows XP SP3 or Windows Vista SP1 with Microsoft .NET 3.5 

is required. 
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3. Parts Description 
The Tribometrics Software ships with two components, the installation media, and a USB hardware dongle.  
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4. Installing the Software 

4.1. Installation Requirements 

The following software packages are required to use the Scratch 4 Machine: 

► The Tribometrics Installer, available on the included CD or DVD, or by download at: 

► https://www.surfacemachines.com/software 

► Microsoft Windows XP SP3 or Windows Vista, Windows 7, 8, or 10 

► Microsoft .NET 3.5 SP1 or later 

► http://www.microsoft.com/downloads/details.aspx?FamilyID=ab99342f-5d1a-413d-8319-

81da479ab0d7&DisplayLang=en 

4.2. Installation Directions 

1. Double-click on the file “Tribometrics-2.11.1.msi” 

2. When you see the following screen, click “Next”. 

 

3. Choose your installation directory, and click “Next”.  If you are unsure about this, leave the default. 

https://www.surfacemachines.com/software
http://www.microsoft.com/downloads/details.aspx?FamilyID=ab99342f-5d1a-413d-8319-81da479ab0d7&DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=ab99342f-5d1a-413d-8319-81da479ab0d7&DisplayLang=en
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4. Click “Next” on the following screen, then click “Next” on this screen. 
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5. Using the Tribometrics Software 

5.1. Starting the Software 

1. Select the “Tribometrics.exe” button from the Start Menu, or double-click the icon on your desktop. 

5.2. The Main Interface 

When you open the Tribometrics Software, you will be presented with the following window. 

 

This is the “Main Control Window”, and all major functionality can be accessed from this window.   

5.2.1. Primary Features 

File Menu – this menu allows you to open and save Scratch Analysis Projects, and to save Scratch Scans 

acquired within the software. 
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Tools Menu – this menu contains access to the analytical tools, and configuration and calibration tools.  The 

Scratch Data Viewer is also available from this menu. 

Options Menu – this menu allows you to control aspects of scratch analysis and gamma correction. 

Scratch Project – this area of the Main Window allows you to select a source specimen scan or acquire a 

scan, and to configure color calibration. 

Scratch Analysis – this area of the Main Window allows you to set analytical settings, and reports analysis 

results. 

Scratch Details – this area of the Main Window allows you to define scratches in the specimen scan, load 

scratch data for each scratch in the specimen scan, and to perform the analysis itself.   

5.3. Overview of Operation 

The high-level process of visual analysis is as follows: 

1. Acquire an image or scan of the specimen at 300 x 300 DPI (11.8 x 11.8 DPmm), along with the color 

correction card. 

2. Load the image into the Tribometrics software. 

3. Select the color calibration regions of the scan. 

4. For each scratch on the specimen, identify the location of the scratch in scan, and load the corresponding 

scratch data from file. 

5. Choose analytical settings. 

6. Perform analysis. 

5.4. Acquiring a Specimen Image 

The Tribometrics software requires an image in TIFF, BMP, or PNG format for analysis.  This image can be 

scanned by using the scanner software included with your scanner, or the built-in acquisition software in the 

Tribometrics software.  There are two ways to load an image of the scan into the Tribometrics – open an 

existing image from disk, or use the built-in scan acquisition. 
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5.4.1. Acquiring Image from the Black Box 

The Tribometrics software should not be used for acquiring images from the Black Box. You will need 

dedicated imaging software to let you adjust f-stop and shutter-speed. After acquiring Black Box imagery, 

follow the instructions in section 5.4.2 to load the image and the instructions in section 5.6 to properly scale 

the image for analysis. 

5.4.2. Open An Existing Image 

To open an existing image saved to your disk, follow these directions. 

All specimen images used by the Tribometrics Software must be at exactly 300 x 300 DPI (11.8 x 11.8 
DPmm) resolution.  Use of other resolutions will result in failed or incorrect analysis. 

1. In the Main Window, in the Scratch Project section at the top, click “Load Existing Image”. 

2. Browse to the location of your specimen image scan on disk. 

3. Select the image. 

4. Click “Open”. 

5. The specimen image scan will be automatically loaded into the Image Display area of the Main Window. 

5.4.3. Acquire an Image from a scanner 

When you perform a scratch, each scratch should be at least 4mm apart, but no less than 1 diameter 
apart.  For 1mm styli, leave 4mm between scratches.  For 10mm barrel styli, leave 10-15mm between 
scratches.  You should place no marks of any kind within 4mm or 1 diameter of the scratch or mar.  
Marks within this region can distort the results of analysis, or make analysis impossible. 

1. Make sure your scanner is plugged into the computer and powered on. 

2. In the Main Window, in the Scratch Project section at the top, click “Scan New Image”.  A window 

similar to the following will appear. 
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3. Select your scanner from the list, and click “OK”.  The following window appears. 

 

4. Click the link at the bottom “Adjust the quality of the scanned picture”. 
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5. In the field “Resolution (DPI)”, enter the value 300.  Click “OK”. 

6. Place the specimen on the scanner, along with the Color Correction Card.  The color correction card 

should be placed near to the specimen, but not underneath or on top of it.  The specimen should be 

arranged such that the traversal of the scanning element runs “down” the scratches as follows: 

 

Some specimens may be too lightly marked to work in the tangential orientation. In that case, you may 
turn them to be parallel to the scanning head. If you do this, ALL specimens must be imaged in the 
same manner. 

Scanning element 

Scan direction 

Color Card 

Specimen 



Surface Machine Systems 

 
 

 

15 

 

7. Click the “Preview” button.  The software will automatically try to detect the specimen in the scan.  You 

can use the white squire “handles” in the preview image to select the desired scan region.  If a scratch is 

near the edge of the specimen, choose a region slightly larger than the specimen – you will need at least 

4mm, but no less than 1 stylus diameter of space around each scratch. 

 

8. Click the “Scan” button. 

 

9. The scan will be loaded in the Tribometrics software automatically. 
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5.5. Configuring Specimen Color Calibration 

Because every scanner varies slightly due to manufacture, each scan must be color calibrated to ensure that 

analysis is consistent between samples. 

10. Selection “Options” > “Color Correction” > “Camera Trax” (or “X-Rite” if you have an X-Rite card). 

11. In the main window, under “Project”, under “Choose Color Standards” click “Color Card Selection”. 
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12. In the Image Display, highlight the color card, center each color block over it’s respective color card 

block. 

 

13. Click “Set Color Card” 

 

5.6. Sizing an Image 

For an image that was captured with a photographic camera rather than a scanner, you will need to size the 

image. This is done with a ruler placed within the imagery. 



Surface Machine Systems 

 
 

 

18 

 

14. Set the length of the scale you are measuring. The longer the better. In this case, we can see 3” of the 

scale, or 76.2mm. 

15. Enter 76.2mm into the “Locate Scale” text box. 

16. Click “Locate Scale”. 

17. Using the cursor, measure from the 4” mark to the 7” mark as precisely as possible along the scale edge. 
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5. Click “Scale Image”. 

5.7. Setting Scratch Analysis Parameters 

The defaults for the parameters for most scratches should be set as follows: 

• Analysis Method: Relaxed 

• Contrast: 3% (2% for high gloss) 

• Continuity: 90% 

• Relax: 80% 

• Contrast Option: High 

• Contrast Method: Simple 

5.8. Creating a Scratch Profile 

Each physical scratch on the specimen should have a Scratch Profile saved in the project.  The Tribometrics 

must be told the location of a given scratch within the specimen scan.  This scratch location is called the 
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visual specimen.  Each scratch should also have a scratch data file associated with it.  Additionally, several 

parameters must be recorded for a scratch, including: 

► A unique name for the scratch 

► Tip diameter in mm 

► Scratch length in mm 

► The velocity of the scratch in mm/s 

► The data capture rate of the scratch 

To add a Scratch Profile to the Scratch Project, follows these steps: 

1. Find the end of the scratch in the Image Display window. 

 

2. Give the Scratch a unique name, such as “Scratch 1”.  Type this name into the field “Scratch Name”. 

3. Click the button “Choose Data File” next to the “Load Data File” field.  In the dialog box, find the 

scratch data file of the scratch.  Select the data file, and click “Open”.  The name of the data file will 

appear in the “Load Data File” field.  Tribometrics will attempt to automatically determine the tip 
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diameter, scratch length, velocity, and data capture rate of the scratch from the scratch data file.  If these 

values are incorrect, you should adjust them now. 

 

4. Click the button “Locate Scratch” under the label “Locate Scratch in Image”.  In the Image Display area, 

find the end of your scratch.  This should be identified by a round “indenter mark”.   

• For Scratches, click the left mouse button in the center of this mark, and drag the mouse along 

the path of the scratch.  A pink line will indicate the path of your selection.  Try to keep this line 

within the center of the scratch.   Although the line does not have to cover the entirety of the 

scratch, the more you select, the more accurately the software can identify the scratch. 

• For Mars, click the left mouse button on the top edge of the mark, and drag the mouse along 

the path of the scratch.  A pink line will indicate the path of your selection.  Try to keep this line 

along the top edge of the scratch.   Although the line does not have to cover the entirety of the 

scratch, the more you select, the more accurately the software can identify the scratch. 

 

5. Click button “Save Mark”.  The Scratch Name of this Scratch Profile will now appear in the “Mark 

Details” list. 
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6. To create additional Scratch Profiles, click the button labeled “New Mark”, and repeat the steps in this 

section for each additional scratch. 

5.9. Reviewing Scratch Profiles 

You can review a Scratch Profile at any time by selecting the appropriate Scratch Profile from the scratch list 

box at the top of the Scratch Details area.  Selecting the Scratch Profile will automatically load the scratch 

information and file as the present scratch. 

You can view the scratch data in for the Scratch Profile currently selected by clicking the button labeled 

“View Analysis”.  This will open the Scratch Data Viewer window to display the data. 

5.10. Updating Scratch Profiles 

You can update a Scratch Profile by selecting the Scratch Profile, and then updating its values in the Scratch 

Details area.  Save changes by clicking the “Save Scratch” button below. 

5.11. Undoing Changes to Scratch Profiles 

You can undo changes to a Scratch Profile by clicking the “Reset” button.  If you save the Profile, this option 

will not work. 

5.12. Delete a Scratch Profile 

1. Select the Scratch Profile from the “Mark Details” box. 

2. Click the “Delete” button. 

5.13. Analyzing a Scratch Specimen 

To analyze the scratch specimen, follow these steps: 

1. Create Scratch Profiles for each scratch in the specimen (see section 5.8). 

2. Save your Scratch Project by clicking “File”, “Save Project”.  Type the name of the project in the “File 

name:” field, and select the output directory you would like it stored in.  Click the button labeled “Save”. 

3. Click the button labeled “Analyze Marks”.  The interface will pause for some time (a minute or more in 

some cases), and a window similar to the following will appear. 
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4. Press “OK”.  If there are any problems in analyzing your specimen, you should receive a warning, and 

the number of scratches analyzed will be less than the number of Scratch Profiles you created. 

5. Below the “Load Scratch” drop down box, a summary of the analysis from the data files is displayed.  

This summary shows the onset of whitening in mm (distance) and Newtons (load) for the presently 

selected Scratch Profile.  It also displays the mean onset of whitening for all Scratch Profiles and the 

corresponding standard deviation from the mean. 

6. You can view the analysis of each scratch by clicking the “View Results” button for each selected Scratch 

Profile.  Once analysis is performed, this button will open two windows: the Scratch Data Viewer and the 

Scratch Image Viewer. 

5.13.1. Analysis Options 

Some scratches have very noises damage profiles which can cause the analysis to find the “end of scratch” 

earlier than expected.  In the image below, the software has identified the beginning and end of the scratch by 

green lines.  The “whitening” area is highlighted in Red.  The onset of scratch is indicated by the light blue 

line at the right of the scratch image.  Clearly, this is too late in the scratch.  Because of the dark regions 

between the whitening areas (highlighted in red), the software read a false positive for the end of scratch.  

These kind of false positives can usually be overcome by using “Relaxed Analysis”.  Relaxed analysis allows 

the software to “skip” over false end-of-scratch readings, and has little or no effect on the resulting analysis 

when compared to scratches which do not require this option. 
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To enable relaxed analysis, follow these steps. 

1. In the “Options” menu, select “Relaxed Analysis”. 

2. The option “Relax (%)” will become enabled in the section “Scratch Analysis”. 

3. For very “noisy” scratches (such as the one above), set this field to a low value, such as 50.  For relatively 

solid scratches, use a high value, such as 80.  A value at or above the “Continuity (%)” value will have no 

effect. 

4. Click the “Analyze Scratches” button again.   The new analysis will now be presented. 

 

5.13.2. Mar Analysis 

For some very wide stylus geometry, it can be difficult to find the center of the scratch.  Additionally, these 

styli produce a very wide path for analysis, which may require a larger background area for contrast 

comparison.  Mar analysis addresses this issue using the Mar analysis option.  In the mar analysis mode, the 

center of the scratch is not selected.  Instead, the top or left side of the mar is selected. 
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To use Mar analysis, follow these steps. 

1. Click “Options”, “Analysis Method”, “Mar”, “Mar (Barrel)”. 

5.13.3. Mar Contrast 

An emerging research standard is mar contrast curve, which measures the visual contrast of a mark 

holistically over it’s whole curve. It is used similarly, but produces a contrast curve output, and contrast 

area under the curve. 

1. Click “Options”, “Analysis Method”, “Mar”, “Contrast Curve”. 

5.13.4. Ironing or Low-contrast Skip 

In some cases, geometric or other effects of the plaque will cause the scratch to fail early in a way in which 

Relaxed Analysis cannot overcome.  For instance, in the scratch below, it is clear that end of scratch marker 

(green line in the center of the processed image) is not the beginning of the scratch.  This is a result of large 
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ironing region with decreased contrast.  To overcome this, you can use the “Assist” option.  The “Assist” 

option is available in the Scratch Image Viewer (displayed below). 

 

To use the Assist option, follow these steps. 

1. In the Scratch Image Viewer, click “Assist”, then “Start Analysis From …” A pink line will be visible in 

the processed region. 

2. Click on the contiguous segment nearest the beginning of the scratch.  This will mark the processed 

image with a pink marker line. 

 

3. Close the Scratch Image Viewer, and run the Analysis again. 

4. The onset of scratch is now found prior to the marker in the scratch region. 
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5.13.5. Gamma 

For most Windows PCs and scanners, the Gamma should be set appropriately.  Some scanners may use an 

alternate gamma of 1.8.  Check the documentation for your scanner.  The gamma must be adjusted prior to 

analysis.  If so, the gamma may be adjust by these steps. 

1. Click “Options”, “Set Gamma”, “Gamma 1.80”. 

5.13.6. Normalization 

Normalization is the method by which the color space of the scratch scan is corrected.  The software defaults 

to “2-Point” normalization.  If your analysis seems to dark (that is, not enough of the scanned region is 

marked as high-contrast), try switching the normalization to “Single Point”. 

When performing analysis between different specimens for comparison, they must all use the same 
analytical settings.  Do not compare results between samples analyzed with different Normalization 
options. 

1. Click “Options”, “Normalization”, “Single Point”. 

5.13.7. Contrast 

By default, the analysis only looks for contrast in the scratch which is higher than background.  This is 

appropriate for black samples, or very high-gloss or chrome samples.  For lighter samples, the settings “Low” 

or “Both” should be used.  The “Low” setting only considered contrast which is darker than the sample 

(generally, ironing effects and shadows).  The “Both” setting is appropriate if you are considering the most 

aggressive possible definition of visibility.  To adjust this setting follow these steps. 

1. Click “Options”, “Contrast Option”, “Both”. 

5.13.8. Contrast Method 

By default, the analysis finds foreground objects using “simple” or trivial, absolute-scale contrast testing.  For 

a color space [0.0 … 1.0], if the background is  (say, 0.1), and the contrast criterion is  (say 3% or 0.03), 

then a foreground object is “of interest” if it’s value  >=  + .  This is the simple contrast method, and is 

set by following these steps. 

1. Click “Options”, “Contrast Method”, “Simple”. 
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A more aggressive method of analysis is Weber contrast, which finds relative changes in contrast in the 

specimen.  This analysis is recommended for very smooth plaques, or for mar analysis.  For foreground 

luminosity IF and background luminosity IB, it is defined as: 

B

BF

I

II −
 

This contrast method can be chosen by following these steps. 

1. Click “Options”, “Contrast Method”, “Weber”. 

 

5.14. Viewing Data 

Once analysis is performed on your specimen, the Tribometrics offers powerful tools for viewing and 

recording your analysis. 

5.14.1. Heads-Up Data and Visual Display 

The Tribometrics provides the facility for you to correlate scratch data with visual phenomena in real-time.  

This functionality is available via the comparator tool. This tool is turned on by default when you open the 

Scratch Profile results after an analysis.  In the image below, the comparator tool can be seen as the vertical 

black line in the Scratch Data Viewer window, and the corresponding white vertical line in the Scratch Image 

Viewer.  As your mouse traverses either the scratch data in the Scratch Data Viewer, or the scratch image in 

the Scratch Image Viewer, the corresponding Comparator line moves in the opposite window. 
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To use the comparator, follow these steps after analysis. 

1. In the Main Window, in the Scratch Details section, click the button labeled “View Results”. 

2. Hover your mouse over an area of interest in either the Scratch Data Viewer window or the Scratch 

Image Viewer Window.  A line will follow your mouse in this window.  A corresponding line will appear 

in the opposite window, and traverse this window along with your mouse in real time.  You can read the 

scratch data from the Scratch Data Viewer window in the “Chart Data” section. 

5.15. Export Scratch Data Chart Image 

You can save the Scratch Data Chart as an image to disk.  Follow these steps to do so. 

1. In the Main Window, click the “View Results” button. 

2. The Scratch Data Viewer and Scratch Image Viewer windows will open. 

3. Resize the Scratch Data Viewer (and chart) to whatever size is appropriate. 

4. Select the Chart Data you would like to have exported to image. 

5. Uncheck the box next to “Comparator”. 

6. Right click on the main Chart Area. 
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7. In the context menu, click “Save Image As…”  A Save File dialog will open. 

8. Choose the output directory and give your image a name. 

9. In the “Save as type:” drop down, select “PNG format (*.png)” or “Jpeg format (*.jpg)” or “Bmp format 

(*.bmp)”. 

10. Click the “Save” button. 

5.16. Export Processed Scratch Image 

To save the scratch image with the processed areas highlighted (the top scratch image), follow these steps. 

1. In the Main Window, click the “View Results” button. 

2. In the Scratch Image Viewer window, click “Save”, “Save Processed”. 

3. In the Save File dialog, give the processed scratch image a name, and select the output directory. 

4. Click “Save”. 

5.17. Export Scanned Scratch Region Image 

To save the scratch image from the specimen scan, follow these steps. 

5. In the Main Window, click the “View Results” button. 

6. In the Scratch Image Viewer window, click “Save”, “Save Scratch Region”. 
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7. In the Save File dialog, give the scratch image region a name, and select the output directory. 

8. Click “Save”. 

5.18. Saving and Opening Projects 

5.18.1. Saving a Project 

1. Click the “File” menu, then “Save Project”.  A Save File dialog box will open. 

2. Give the project a name, and choose the directory your project will be saved in. 

3. Click “Save”. 

If you project has already been saved, then clicking the “Save Project” button will cause the software 
to update the saved project on disk rather than opening the dialog box. 

5.18.2. Save a Copy of a Project 

1. Click the “File” menu, then “Save Project”.  A Save File dialog box will open. 

2. Give the project a name, and choose the directory your project will be saved in. 

3. Click “Save”. 

5.18.3. Opening a Saved Project 

1. Click the “File” menu, then “Open Project”.  A Open File dialog box will open. 

2. Navigate to the directory containing your project. 

3. Select your project. 

4. Click the button labeled “Open”. 
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6. Troubleshooting 

6.1. Scratch could not be analyzed, or an Out of Memory 

Error occurs  

Scan is Clipped 

It may be that the specimen scan is clipped to close to the sides, beginning, or end of the scratch.  Increase 

the scan size of the specimen. 

Wrong Scratch Length is Entered 

Check the scratch length entered into the Scratch Profile.  A scratch length which is too long for the scratch 

may cause an error. 

Scan is at the wrong resolution 

Make sure you have scanned the image at exactly 300 x 300 DPI (11.8 x 11.8 DPmm). 

6.2. Reported onset of scratch does not match or is 

insensible 

Scan is at the wrong resolution 

Make sure you have scanned the image at exactly 300 x 300 DPI (11.8 x 11.8 DPmm). 

6.3. Some of your parameters may be 0 or negative… 

Check the “Tip Dia (mm)” field. 

6.4. Standard Deviation is very high 

Try using “Relaxed Analysis”. 

1. Click “Options”, “Relaxed Analysis”. 
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2. Click “Analyze Scratches”. 

Try using the “Assist” option from the Scratch Image Viewer. 

1. For each scratch, click “View Results”. 

2. Click “Assist”, “Start Analysis From …” 

3. Select the last contiguous scratch region marked in the processed region. 

4. Re-run analysis 

6.5. The scratch region is very wide or it is difficult to find 

the center 

Try using Mar Analysis.  Mar Analysis requires you to select the top or left edge of the scratch. 

1. Re-select your scratches using the top or left edge of the scratch. 

2. Click “Options”, “Analysis Method”, “Mar (Barrel)” 

6.6. Data files from Kato Tech Co. take a long time to load 

This is a result of Microsoft’s public import routines.  This is expected behavior. 

 


